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Welcome

| Welcome to Stitch & Motif Maker V3. Stitch & Motif Maker is a tool designed for the hand knitter to assist
in the creation of textured motifs, color work or the combination of both.

The most spectacular knitted fabric is usually made up of a recurring group of stitches, thus the word motif
in the name. We knitters need only to grid the number of stitches in one motif. As in music, we repeat the
stitches as we are knitting to create a memorable melody in our finished fabric.

Stitch creation and reinvention is an exciting adventure. I use Stitch & Motif Maker in many ways. I create
my own patterns. I redo charts in a commercial pattern with the colors that I am using in a particular
knitting project. I import clipart and convert it to knit stitches to use as the basis for Intarsia patterns. I
could go on forever, but I know that you really want to start using the program.

Version 3 expands on the earlier version and now provides the user with grids built to gauge, unending
cable building and awesome custom colors.

Please take a few minutes and do the Getting Started exercise contained in the first book of help to
familiarize yourself with the program. You will soon be on the road to original design.

Visit us at www.software4knitting.com or join the Yahoo! Discussion Group.
As always, [ am only an email away (support@software4knitting.com) if you have questions or

suggestions.
Carole

Building Charts

Before you start building your charts or stitches, I would like to take a moment and share some of
my thoughts on the process with you.

Please review in your mind how knitting instructions are presented in your favorite patterns or
magazines. The charts are usually built in small sections. In other words, you do not see a chart of
a whole sweater but several charts. Each chart has one repeat of the given pattern.

There is a reason for this type of presentation. Charting a stitch or a color design makes it easier to
visualize and thus memorize it. If the knitter were presented with a chart of every stitch in the
sweater or afghan, there would be no way to ever break the pattern down to a rhythm.

Before charts with symbols, we had written instructions providing the repeat and then the number
of times to repeat across the row. This is exactly the end you wish to accomplish when building
your charts.

For a complicated Aran, you may have 5 different charts. For a complex Fair Isle, you may have
several charts.

If you think small, rather than big, it will be much easier to design your stitch patterns on the
computer and you will not be putting a strain on your system’s memory.



Message to Users of Previous Versions

I hope that you find the new features in this version of Stitch & Motif Maker useful. Many of them
are a result of your suggestions.

Since you cannot open files which were saved with older versions of Stitch & Motif Maker, this
program is constructed so that you do not need to remove the previous version from your system.
You may use both. The installation program will create a new folder and not delete the older
version from your system

I deeply apologize for the lack of downward compatibility, but to incorporate the features most
requested, I needed to change the Save/Open functions and program file structure.

Carole

Getting Started

Exercise 1

Create a New Grid to Gauge
Open Stitch & Motif Maker.
Click File Menu.

Click New.

The New Dialog Box will appear.

Mew Grid Dimenzions %

StsPerin [f Stiiches  [10
Rws Ferin |5 Rows |12

o OK

Change the gauge to 5 sts per in, 7 rws per in.
Change the grid size to 22 sts, 23 rws.
Click OK.

You will have a new grid.
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Exercise 2

Start a Color Motif

Note that the Drawing Toolbox is next to the grid.
Depress the Pencil Button if it is not already depressed.
Choose a color. I chose the bottom left color.

Note that the Current Stitch box in the top toolbar has changed to the chosen color.

n @ strw: (17, 2) C]

Begin filling in the grid.
Move your mouse to stitch 1, row 1. Depress the left mouse button.

The first stitch is filled with the chosen color. Continue to depress the left mouse button and move
over stitch 2. Release the mouse button.

Continue in this manner until the grid looks like the one below.



I
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You have just completed the bottom right hand corner of the motif.

If you wish to stop, save your file so you can use it for the next exercise.

Exercise 3

Copy and Paste

The top right hand corner will be the same as the bottom right hand corner of this repeat. Rather
than drawing it the color block stitch by stitch, it makes more sense to copy and paste it into
position.

Click Select button on the Drawing Toolbox—i

Place the mouse cursor at the intersection of stitch 4 row 7. Depress the left mouse button and drag

B

to the bottom corner. * * * '

The motif is selected.

B
lick the Copy button on the Drawing ToolboxE_I

Click the Paste button on the Drawing Toolbox-m—ig

The Paste Toolbox will appear at the left of your grid.



Move the mouse over the image of your motif in the Paste Toolbox. Depress the left mouse button
and hold it down as you start dragging the image.

z

To paste: Drop (release the left mouse button) when the motif is positioned correctly in the top
right corner.

There are now duplicate images at the bottom right and the top right.
Close the Paste Toolbox by clicking the X in the top right corner.

If you wish to stop, save your file so you can use it for the next exercise.



Exercise 4

Building the Motif: Use Flip to complete

Please note that in this exercise we will be pasting over the area at the top of the chart from the
exercise above. This may seem to be a duplication of effort. However, it will demonstrate how
with a little forethought, one can save some effort.

Click the Pencil Button and build the motif as pictured below.

To erase a stitch, right click on the stitch.

To Undo an area, click the Undo button. X
Half the motif is built.
Click Select button

Starting at the intersection of stitch 22 and row 11, select the complete bottom portion of the grid.

Click Copy
Click Paste

The Paste Toolbox will open.



It will cover the top half of your grid. Depress the left mouse button over the title bar of the Paste
Toolbox and move the toolbox toward the bottom of the grid.

Drag the image in the Paste Toolbox to the top of the grid. Drop it starting at row 23.

There is now a double image of the bottom of the grid.

a

Z H B WA @S T % B W @ o#W W NI T E F

Click the Select button.

Select from the intersection of stitch 22, row 23, to stitch 1 and row 13.
Click Edit Menu

Click Flip

Click Vertically

The image is complete.

]

If you wish to stop, save your file so you can use it for the next exercise.

Exercise 5

Change Color, Save, Print



You have built your first motif. Look at it closely. Is it going to work?

Look at row 12. Notice there is only one light green stitch in the middle. There will be a huge float
on row 12. To avoid this, randomly add new colored stitches.

To see what the motif would look like on a blue background; click the color blue in the Drawing
Toolbox.

Click the Change Color Button. g
Click on any white grid square.

Looking good, but we don’t need to waste all that colored ink.

Click Undo button and the background will return to white.
Click File

Click Save

Name your file and save it.

Click File Menu

Click Print.

Congratulations! you have finished your first motif.

Getting Around
Default Grid
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The program opens to a default grid of 10 stitches and 12 rows.
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The default grid is scaled at 4 stitches/5 rows per inch.

The grid is the drawing area. Each grid block can be filled with a stitch, color or combination of
both.

Drawing Toolbox

Drawing ‘Z|

%, Symbols | Cables | Cables Il Colors |Misc |

e

Basic Colors Custom Colors

W |
T
I
EE B
CE W [

lcolors.
Custom Colors

l:ll:”:”:”:l Click to

FNOCCINE

& ECEE

choose
1O 0]
1O 0] .
L1101 0

|§Clear All Custom Colors I

The Drawing Toolbox is a free moving window. To facilitate working on the grid, the tool box can
be moved to any convenient spot on the screen. By moving it near the work area, long mouse
movements can be eliminated.
The toolbox has several components :
Drawing Tools, which are arranged in a vertical bar along the left side of the toolbox.
Tool area tabs, which are arranged by the types of motifs you wish to use:

Symbols

Basic Symbols

Building Cables

Misc

Color

11



Basic Colors

Custom Colors

Hints which appear at the bottom of the toolbox as you place your mouse on a symbol or cable, or
in a dialog "bubble" as you mouse over the symbol.

Courtesy of Raye Schwartz

Drawing Tools

3] L] ] | |

K

ol el b

The Drawing Tool Bar contains buttons for each editing task needed to create stitches and motifs.

K. Pencil Button

When the program opens, the Pencil Button is depressed. Depressing the Pencil Button allows
the user to choose a symbol or color to draw on the grid.

Click on a symbol or color. The symbol or color will appear in the Current Stitch box on the main
toolbar below the menus. Click on any grid square and the symbol or color will be copied to the

grid square. By holding the left mouse button down, a color or stitch can be drawn continuously
until the mouse button is released.

2 | Eraser Button

12



Depress the eraser, move to the grid. Depress left mouse button and erase stitches.

Stitches may also be erased during the drawing process by clicking the right mouse button.

£ Eyedropper Button

The eyedropper is a pick tool. You do not use this on any of the symbols or colors on the tabs.
This tool is for the grid. If there is a color or symbol on the grid that you wish to use again, click
the eyedropper, then click on the grid square you wish to reuse. The Current Stitch now becomes

the stitch or color that was chosen. The Pencil Button is depressed and you can begin drawing
with that stitch or color.

g Change Color Button

The Change Color Button only works with colors. The purpose of the tool is to change one color
to another throughout the whole grid.

Change Color can be implemented in two ways.
Current Color

Click the Change Color Button, click on a grid square that is different than the color in the Current
Color box. The color of that grid square and all grid squares of the same color will change to the
Current Color.

New Color
Click the Change Color Button.
Click a color from the Colors Tab.

Click on a grid square that is the color you wish to change.

Vertical Line Button

Depress the Vertical Line Button to draw a vertical line on the grid. The line will draw to the right of the
closest grid line. If you wish to use color, depress the button with your mouse, click a color, and draw the
line on the grid. The default line is black.

o Depress the Horizontal Line Button to draw a vertical line on the grid. The line will draw just below
the closest grid line. The default line is black. If you wish to draw a horizontal line in color, depress the
button with your mouse, click a color, and draw the line on the grid.

| ™ Combine Button

13



Use the Combine Button to combine a stitch and a color in one grid square. You must follow the following
sequence to generate the correct result.

Click the Combine Button.
Click a stitch or color on the Drawing Toolbox.
If you clicked a stitch, click a color, or vice versa, on the Drawing Toolbox.

The Current Stitch box is now filled with your combined stitch and color and the Pencil Button is
automatically depressed ready for the drawing. Click on the grid where you want the combined stitch/color
to appear.

Courtesy of Judy Anderson

15 Select Button

Click the Select Button. Move the mouse to the grid. Select an area. A red rectangle will be drawn around
the selected area. To deselect, click the Select Button again.

Cut Button

Cut Button is disabled until an area is selected. Once the area is selected, click Cut Button and the grid will
return to white squares.

Copy Button

Copy Button is disabled until an area is selected. Once the area is selected, click Copy Button to make a
copy to be used with Paste Button.

D—ﬁ Paste Button

Paste Button is disabled until either cut or copy has been implemented. Clicking Paste Button will open the
Paste Tool Box.

o Fill Button

Fill Button is disabled until an area is selected. If you wish to fill the area with the Current Stitch, click Fill
Button and area will automatically fill. If you wish to fill with a different stitch or color, click the color or
stitch first and then click the Fill Button.

*7 1 Undo Button

14



Click Undo Button to undo your last action. Undo will be disabled after you insert or remove a row or a
stitch. All undos before the action will be lost. Undo will be enabled after the grid is drawn on again.

Paste Toolbox

Pasting is implemented using the Paste Toolbox.

Once an area is selected and copied, the Paste Toolbox will appear on the screen. The Paste
Toolbox is moveable to any area of the screen. It is recommended that it is moved close to the area
of pasting.

Paste... EI

To move the toolbox, click on the blue border at the top and drag into position. Please note that
clicking and dragging on the border only moves the toolbox. It does not implement pasting.

To paste, depress the left mouse button over the image inside the toolbox. With the left mouse
button still depressed drag the image to the area to which it is to be pasted. Release the mouse
button and pasting will be complete.

15



Undo if the position is not correct. Remember that the image needs to line up with the grid. Paste
just below and to the right of the grid intersection. The pasting image will snap to the grid.

T1

n

Grid Line Colors

The default color for the background lines is silver, the bold lines are black.
The spacing is 5 stitches and 5 rows.

To customize the colors of the grid lines:

Click Canvas Menu

Click Grid Lines

The Grid Lines Dialog Box will appear. The default color for the background lines is silver, the
bold lines are black.

16



Bold Lines

oK

Bold line every sts
Bold line every ]5 rWs

Cancel

Grid Lines | [ Silver =il

Bold Lines 1- Black :J

Change the bold line spacing to the desired preference by typing the number in the stitch and row
box.

Change the colors by clicking the drop down arrow in each color selection box.

Bold Lines R‘

OK

Bold line every ]-:1- sts
Bold line every JE WS

Cancel

Grid Lines | Red |

Bold Lines | I [RJEEEE ]

The grid will change.

Use this feature when a color is too close to the default grid lines. If you prefer not to have bold
lines, set the bold lines to the same color as the background grid lines.

17



12 9 & T ] 5 4 3 2 1

On some systems, the colors at the bottom of the list may appear without a name but with a
hexadecimal declaration (for non-computer people, this is a mixture of digits and letters which
computers use to "talk to" hardware components, such as video display). The color denoted by the
declaration is in the box next to the hexadecimal notation.

| . Furple

Bl Glue

B Fuchsia
] Aqua

] White

[_] s00coDCCo
[ S00FOCAAG
(__] S00FOFBFF

] 500A4A0A0

Hint Area

At the bottom of the Drawing Toolbox, you will find a Hint section.

The Hint section defines the stitches, or describes the current tool or menu. In addition, the hint
will appear in a dialog bubble when your when the mouse hovers over the button or menu.

18
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To design a stitch or textured pattern using symbols, click the Symbols Tab.

Symbols are visual cues providing information regarding the manipulation of a stitch or a number
of stitches used in knitting. Below are the definitions of the symbols used in Stitch & Motif
Maker.

You will notice that there are often several different ways of depicting a symbol. I have included
a variety of popular publications to reflect your preferences. Please see the resource section at the
end of this help file for a list of the knitting dictionaries or publications which have provided the
basis for this selection of knitting symbols. Courtesy of Raye Schwartz

Row 1:
Knit Stitches
| Knit on the right side, purl on the wrong side.
*+ Knit.
M Knit through the back loop.
 Knit through the back loop.
b Knit through the back loop.
4 Knit in the row below.
m Knit through the back loop in the row below.
u Knit 1, wrapping yarn twice.

# Knit 1, wrapping the yarn 3 times.

Row 2:

Purl Stitches

= Purl on the right side, knit on the wrong side.
H Purl through the back loop.

4 Purl through the back loop.

a Purl through the back loop in the row below.

Row 3:
Right Slanting Decreases
# Knit 2 stitches together.

#1 Knit 2 stitches together.

20



# Knit 2 stitches together.
4 Knit 2 stitches together.
A Knit 2 stitches together.
£ Purl 2 stitches together.
* Purl 2 stitches together.
¥ Purl 2 stitches together.
& Purl 3 stitches together.

& Purl 3 stitches together.

Row 4:
Left Slanting Decreases

 Slip, Slip, Knit (ssk).

Slip the next two stitches as if to knit. Insert the point of the left needle into the fronts of the two

stitches and knit them together.

M Slip, Slip, Knit (ssk).

™. Slip, Slip, Knit (ssk).

+ Knit two stitches together through the back loop.

k Slip 1 stitch, knit 1, pass slipped stitch over knit stitch.
L& Slip 1 stitch, knit 1, pass slipped stitch over knit stitch.

2 Purl 2 stitches together through the back loops.

Row 5:
Centered Decreases
4 Slip, slip, knit, knit 2 together. [SSK, k1, k2tog].

> Slip 1, knit 2 together, pass slipped stitch over knit 2 together.

< Slip 1 stitch knitwise, knit 2 stitches together, pass slipped stitch over.

A Knit 2 together, slip 1 stitch, pass knit 2 together over slipped stitch.
- Slip 2 together knitwise, knit 1, pass 2 slipped stitches over knit.

< Knit 3 together.

A Knit 3 together.

- Khnit 3 together.

21



a Slip 2, knit 1, pass 2 slipped stitches over.

Row 6:
Right and Left Slanting Increases
M Make 1 slanting to the right.
Il Make 1 slanting to the left.
M Make 1, knit.
M Make 1, purl.

M Make 1.

Row 7:

Other Increases

% Make 1, eyelet.

¥ Work 1, yarn over, work 1 in the same stitch.

" Increase one by working in the front and back of the same stitch.
W Increase 2 stitches in the same stitch.

¥ Increase 3 stitches in the same stitch.

W Increase 4 stitches in the same stitch.

¥ Increase 5 stitches in the same stitch.

W Increase 6 stitches in the same stitch.

¥ Increase 7 stitches in the same stitch.

Row 8:

Bobbles

B Bobble.

s Bobble: 5 stitches.
® Bobble.

+ Knit, purl, knit in one stitch.

Row 9:

22



Slipped Stitches
W Slip 1 stitch knitwise.

% Slip 1 stitch purlwise.

= Slip 1 stitch with yarn in front (right side) to create a float.

se Slip 1 stitch purlwise.
S Slip 1 stitch knitwise.

& Slip 1 stitch purlwise.

Row 10
Yarn Overs
O Yarn over.

00 Yarn over two times.

Row 11

Twisted Stitches

% Knit through back loop to twist stitch.

8 Purl through back loop to twist stitch.

£ 2 stitch left twist.
~=< 2 stitch right twist.
7. 2 stitch left purl twist.

=0 2 stitch right purl twist.

Row 12

Misc

£ Knit 4 together.
A Knit 5 together.
A& Knit 6 together.
# Knit 7 together.
t Selvage stitch.

m Blank stitch.

23



Building Cables

Stitch & Motif Maker uses a modular system made popular in Europe to build cables. This system
does not limit you to a specific number of stitches used in each cable.

Before using the cable system it is important to understand the basic concept of the symbols. On
the first cable page, there is a set of double symbols. Each of these symbols represents the
direction in which the stitches will cross each other to form the cable.

— The diagonal line describes the direction. The diagonal line in the symbol at the left moves
from the bottom left to the top right. This indicates that the cable will cross to the right.

To achieve a right slant in knitting, the stitches in the grid before the diagonal line are placed on a

cable needle and held in back. The stitches coming next are worked, then the stitches from the
cable needle are worked.

Read cable symbols in the following order:
1. Diagonal Line:

o Direction of the cross. Bottom left to top right — cross to the right. Bottom right to left top — cross
to the left.

e Cross to the right: hold stitches in the back of the work.
e Cross to the left: hold stitches in front of work.
2. Number of stitches to be slipped to the cable needle.

e Number of stitches to the left of the diagonal line. Grid blocks numbered 1 & 2 in the diagram are
the number of stitches slipped to the cable needle.

3. Working the cable.

o Grid blocks numbered 3 & 4 are symbols for the stitches worked on the left needle. These stitches
are worked first.

24



Grid blocks numbered 1 & 2 are the symbols for the stitches on the cable needle. These stitches
are worked second.

4. Read the diagram as

Slip 2 sts onto cable needle.

Hold cable needle to the back.

Knit the next two stitches.

Purl the two stitches from the cable needle.
b JENE
1 3 2

Read this cable as

Slip 1 to cable needle, hold in back, K2, P1 from cable needle .

1 T
Read this cable as

Slip 2 sts to cable needle, hold in back. Knit next 2 stitches. Knit 2 stitches from cable needle.

RS R

Note that the diagonal line in this cable slants to the left.
Read this cable as

Slip 2 sts to cable needle, hold in front. Knit next 2 stitches, Knit 2 stitches from the cable needle.

Many cables have you combine stitches.

This is a combination of knit and purl.
| =T

|

Read this cable as

Slip first two stitches to cable needle. Hold in back. Purl next two stitches. Knit the stitches from
the cable needle.

25



Each cable symbol has a companion truncated symbol. Use the truncated symbols as end stitches
when two cables or more cables or crossed stitch patterns are adjacent. Below is an example of a
honeycomb stitch pattern using truncated symbols with the full symbols.

— —_—
Pl Ll L L b N D DR Ll L LA D] T
3
Ll 0 DR bl LA ]I ] fs
3
1
5 w1 12 1" 1w 8 & 7T 6 5 £ 3 1

In the honeycomb chart above the pattern is only worked on rows 5 and 11.

End stitches were used on either side of each 4 stitch twist to distinquish between the cables.
The pattern would read:

Row 1: Knit.

Row 2: Purl.

Row 3: Knit.

Row 4: Purl.

Row 5: Slip 2 stitches to cable needle, hold in front of work, k2, k2 from cable needle. Slip 2 sts to
cable needle and hold in back, k2, k2 from cable needle. Repeat 1 more time.

Row 6: Purl.
Row 7: Knit.
Row 8: Purl.
Row 9: Knit.
Row 10: Purl.

Row 11: Slip 2 sts to cable needle and hold in back, k2, k2 from cable needle. Slip 2 stitches to
cable needle, hold in front of work, k2, k2 from cable needle. Repeat 1 more time.

Row 12: Purl

26



Since the background is done in stockinette stitch, there is no need to draw in the knit and purl
rows.

Cable Symbols

Sz s
=T T=  _= =_
L= =mL =T T
N
P N e V)
= =

B i i i —

End Stitches

Note: cn is the abbreviation for cable needle.

Knit Stitches

Row 1:

1T Right cross: Slip 1 to cn, hold in back, k1, k1 from cn.
™1 Left cross: Slip 1 to cn, hold in front, k1, k1 from cn.
— Right cross: Slip 1 to cn, hold in back, k1, k1 from cn.

_ Left cross: Slip 1 to cn, hold in front, k1, k1 from cn.

Knit and Purl Stitches

Row 2:

=-T Right Cross: Slip 1 to cn, hold in back, k1, p1 from cn.
= Left Cross: Slip 1 to cn, hold in front, p1, k1 from cn.
—~= Right Cross: Slip 1 to cn, hold in back, p1, k1 from cn.

=~_ Left Cross: Slip 1 to cn, hold in front, k1, p1 from cn.



Row 3:

/= Right Cross: Slip 1 to cn, hold in back, p1, k1 from cn.
=1 Left Cross: Slip 1 to cn, hold in front, k1, pl from cn.
=" Right Cross: Slip 1 to cn, hold in back, k1, pl from cn.

= Left Cross: Slip 1 to cn, hold in front, p1, k1 from cn.

Twisted Stitches

Row 4:

=7 Right Cross: Slip 1 to cn, hold in back, k1 through back loop, k1 through back loop from cn.
. Left Cross: Slip 1 to cn, hold in front, k1 through back loop, k1 through back loop from cn.
_- Right Cross: Slip 1 to cn, hold in back, k1 through back loop, k1 from cn.

™_ Left Cross: Slip 1 to cn, hold in front, k1, k1 through back loop from cn.

Row 5:

== Right Cross: Slip 1 to cn, hold in back, p1, k1 through back loop from cn.
=z Left Cross: Slip 1 to cn, hold in front, k1 through back loop, p1 from cn
—= Right Cross: Slip 1 to cn, hold in back, k1, k1 through back loop from cn.

T Left Cross: Slip 1 to cn, hold in fron, k1 through back loop, k1 from cn.

Row 6:
=7 Right Cross: Slip 1 to cn, hold in back, k1 through back loop, p1 from cn.

™= Left Cross, Slip 1 to cn, hold in front, p1, k1 through back loop from cn.

Cable Expansion Stitches
Row 7:

-L Knit stitch with bottom bar.
T Knit stitch with top bar.

= Purl stitch with bottom bar.

= Purl stitch with top bar.

28



< Twisted stitch with bottom bar.
= Twisted stitch with top bar.
— Knit stitch with bottom bar.

" Knit stitch with top bar.

End Stitches

The last two rows are the same symbols as above, however the bar is truncated at either the right
or left end. Use these stitches as beginning or end stitches for the cables if cables are contiguous to

distinguish from one cable to the next.

Truncated Cable Symbols

ST 1T T ARl ARl
=T mST - T T T
el o Fa . e rer
- e - Rk R -
== = == ==
A e
R e B e (s
A i =7 T T

The Cables II Tab is comprised of all the cable symbols on the Cables Tab however each symbol

is truncated on the right, left or both sides.

These symbols are to be used when cables are contiguous to distinguish one cable from another in

the grid.
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Misc Symbols

Miscellaneous symbols are provided for the user’s convenience. I often use the symbols from the
Misc Tab to denote color work when I do not wish to print in color.

Below is an example.

EJEIEIEIMEIEIE I FEIES 12

EAEIEIEIEIEIEIEIEIEFEIEIETNNEE

EJES R EEFEEFE] (0

E3ES EEAEIEIEIEIEIEIETINE

EAEIEIEIEIAEIEIEIEIEIEIETIE

EAEIEIEIEIEIEIEIEIES 7

E3ES E3ES 3

* * 5

* * 4

EJES EJES 3

EAEIEIEIEIEIEIEAEIEFEIEIEIEIEIEIRT

EJES EJES 1
1615 1a[ 15[ 12[11[0]s [& [7 |6 |5 |+ [3 |2 |1

30



Colors

Basic Colors

Basic Colors

Basic colors are found on the Colors Tab. The colors represented in the color grid are the system
colors as set in the individual computer environment. The colors seen on your computer may
differ from those represented here.

Basic color are always solid colors. They are never dithered. Dithered Colors are those which look
speckled. They are common with older systems.

If you choose to use black or silver in the grid, you may wish to change the grid line colors.

Custom Colors

| Custom Colors are created by mixing the colors in the gamma box. You will find the gamma box
on the Colors Tab.

Custom Colors

Mouse
over

icolors.
Click to
choose
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Slowly move your mouse over the gamma box until you have exactly the correct mix. Click the
left mouse button. The color will appear in the first available white space below the Basic Colors.

Custom Colors

EECICI]
LI
LI
LIt

To use the color on the grid, depress the Pencil Button if it isn’t already down. Click the new
color box. The color will then become the color in the Current Stitch. Click anywhere on the grid
to begin drawing.

Custom Colors can be cleared in two ways.
To clear one custom color, right click the custom color and it will return to white.

To clear all, click the Clear All Custom Colors button.

Clear All Custom Colors

When you save your design as a Stitch & Motif Maker file, your custom colors will be saved with
the file. When you reopen the file, the custom colors will be in place.

If your custom colors are not solid, try setting your Windows color scheme to 24 bit color. Non-
solid colors are dithered colors. It is not a fault of the program. Dithered colors are the result of
Windows compensating for the colors allowed or set by a particular system.

Using Stitch & Motif Maker
Grid Size and Gauge

When the program opens the default grid size is 10 stitches x 12 rows. The gauge is 4 stitches per
inch, 5 rows per inch. The maximum grid size is 80 x 100.

The 80 x 100 grid is maximum due to memory constraints. If you find working with a grid that
large slows up your computer, then split your work in half and create two grids.

To change the grid size and or the gauge:
Click New.

Enter in the desired gauge and size of the grid in the dialog box.
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New Grid Dimensions ‘Y‘

Sts Perin [q Stiches [10
Rws Per In ]5 Rows }12

v OK

Once you have entered in the gauge and start working on your grid, you cannot change the gauge
unless you start from the beginning again.

For color work, the gauge is very important to give you the aspect ratio of your knitted stitches.
Since large grids take a considerable amount of memory, when working in color, consider
doubling your gauge. For example, if your gauge is 4sts/Srws, make the grid 8sts/10rws. This will
give you the same aspect ratio and more stitches in the viewable area of your screen.

For textured stitches gauge is not as important. When working with symbols find a gauge that is
most comfortable on your eyes in the final printing. As you work with the program and the
symbols, you will get a feel for what is best for you and your computer system.

Insert a Stitch or a Row

To insert a stitch:

Click Edit Menu.

Click Insert.

Click Stitch.

Move the cursor to the stitch just to the right of the stitch you wish to insert.

Click the left mouse button. A new stitch will appear.

In the example below, I want to insert a stitch between the green and red stitches.

After clicking Insert and Stitch on the Edit Menu, I clicked on stitch 5. This is the result.

33



To insert a row:
Click Edit Menu.
Click Insert.

Click Row.

Move the cursor to any stitch in the row below where you wish to insert the new row.
Click the left mouse button. A new row will be inserted.

Undo becomes disabled after inserting a stitch or a row. To remove the stitch or row, see Remove
a Stitch or Row.

Remove a Stitch or a Row

To remove a stitch:
Click Edit Menu.
Click Remove.
Click Stitch.

Move the mouse to the stitch you wish to remove. Click the left mouse button. The stitch will be
removed.

To remove a row:
Click Edit Menu.
Click Remove.
Click Row.

Move the mouse to the row you wish to remove. Click the left mouse button. The row will be
removed.

Undo becomes disabled after removing a stitch or a row. To add a stitch or row see Insert a Stitch
or a Row.
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Drawing

To begin drawing:

Click the Pencil iconﬁ . on Drawing Toolbox.

Click on a color or a symbol, or a symbol and a color if drawing with both.

Move your mouse over the grid.

To paint one stitch at a time, click on the grid square and release the mouse button.

To paint a group of stitches, click on a grid square, keeping the mouse button depressed and move
over the stitches you wish to paint. When finished, release the mouse button.

The pencil icon must be depressed in order to draw on the grid.

Eyedropper Tool

The Eyedropper is used to reproduce stitches or colors already present on the grid.

To use the Eyedropper tool

Click the Eyedropper icon.£

Click on a grid square containing the symbol or color you wish to reproduce. The stitch or color
will appear in the Current Stitch box.

You can now paint with that color or symbol.

The Eyedropper will not reproduce double symbols.

Erase

To erase one stitch, click right mouse button on the stitch.

To erase several stitches, click Erase icon on Drawing Toolbox.

Move the mouse to the grid. Depress left mouse button and drag to erase.
To erase a large area:

Select the area.
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Click the Cut icon on the Drawing Toolbox.

Select

| Select an Area

=

To select an area, click the Select icon on the Drawing Toolbox.
Move the mouse to a grid intersection to begin selecting.
Depress the left mouse button and begin dragging to the final intersection.

When area is selected, release the mouse button.

Select All.
Click Edit Menu.
Click Select All.

The complete grid area will be selected.

Cut

| Select an area.
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Cut Methods:

1. Click Cut icon on Drawing Toolbox.
2. Click Edit Menu, click Cut.

3. Use key combination of Ctrl + x.

Should you wish to paste the cut selection to a new area, click the Paste icon on the Drawing
Toolbox. The Paste Toolbox will open. Refer to Pasting for paste instructions.

Copy

Select an area.

Copy Methods:

B
1. Click Copy icon E on Drawing Toolbox.
2. Click Edit Menu, click Copy.

3. Use key combination of Ctrl + c.

To paste, refer to pasting.

Pasting

Pasting in Stitch & Motif Maker does not involve the clipboard. Once an area has been selected

and copied or cut, click the Paste icon. D—t
The Paste Toolbox will appear. Paste is a drag and drop operation.

Move the Paste Toolbox near the area to which you wish to paste. The toolbox is moved by
depressing the left mouse button in the title bar and dragging the whole toolbox into position.

To paste, move the mouse to any area of the graphic in the toolbox. Depress the left mouse button
and hold it down. Begin to move the mouse with the button still depressed. You will see a
transparent image of the graphic in the toolbox begin to move across the screen under your mouse
pointer.

Position the ghost image just to the right and just below the grid intersection at which you wish to
paste.

Look at the pictures of pasting in Exercise 3 of Getting Started.
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The Paste Toolbox will remain on the screen until you close it or another paste operation is
initiated.

If the paste is not in the correct area, click the Undo icon “7land try again.

Undo

There are 15 levels of Undo in the program. They are related to the task you have performed.

Methods of Undo

1. Click Undo icon **
2. Use the keystroke combination of Ctrl + z.

3. Click Edit Menu, click Undo.

Flip Horizontally
1. Select the area which you wish to flip.
2. Click Edit Menu.
3. Click Flip.

4. Click Horizontally.

Flip Vertically
1. Select the area which you wish to flip.
2. Click Edit Menu.
3. Click Flip.

4. Click Vertically.
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Import

Stitch & Motif Maker will import three graphic formats: .bmp, .jpg, and .wmf files.
.bmp — bitmap

Jpg

.wmf — Windows metafile

To import, select an area of stitches or Select All. With the selection box in place
Click Edit Menu.

Click Import.

Click File Type.

Some .jpg files will not import. That is not a limitation of the program, but is related to how the
original file was created.

Note: This program does not do color reduction. The best and easiest type of files to import and
turn into knitting designs are clipart files, anything akin to coloring book art. A photograph that
has been scanned will be almost impossible to stylize into a knitted fabric in Stitch & Motif
Maker. Keep in mind that the more detailed the graphic the harder it will be to knit.

The imported file will be sized to your selection. It is best to consider the finished size of the motif
before you import. For example, if the gauge is 4 / 5 and the desired size of the knitted motif is 3 x
4 inches then you would select an area of 12 sts x 20 rws. The program will reduce or enlarge the
graphic to the selected area.

You cannot import Stitch & Motif Maker generated graphics. The result will be overlapping grid
lines.

Row Numbering

The default is that odd numbered rows are numbered on the right and even numbered rows are
numbered on the left.

To change the row numbering format:
Click Canvas.
Click All and all rows will be numbered on the right.

Click Odd and all rows will be numbered with odd numbers. Each row will represent two rows, i.e
1,3,5.

Click Even and all rows will be numbered with even numbers. Each row will represent two rows,
ie. 2,4,6.
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Line Tools

There are times when a motif or pattern is finished that a horizontal or vertical line in a different
color may help in reading the charts.

The Line tools are meant to be finishing touches to your motif.

Vertical Line

¥

Click the Vertical Line icon = .
The tabs will go to the Colors Tab.
Click a color.

Move to the grid and begin drawing from top to bottom to the right of the grid line that you wish
to highlight.

Horizontal Line

Click the Horizontal Line icon =*

The tabs will go to the Colors Tab.
Click a color.

Move to the grid and begin drawing from left to right just below the gridline you wish to highlight.

Combine Stitches and Color

In certain circumstances, you may wish to combine stitch symbols in color.

Stitch with Color:

1. Click Combine iconl ~ on Drawing Toolbox.
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Click on the stitch symbol.

3. Change tab.
Symbols

Basic (
B

g- Click on the color.

@ | strw: (3, 3) -

5. | Note the Current Stitch has become the combined
stitch.

_mmm

3 z 1

[¥ [ [S £

6. Move to the grid and click stitch for placement.

Color With Stitch

1. Click Combine icon. ~

2. Click on color.

3. Change tab.

4. Click on stitch symbol. Note the Current Stitch has become the combined stitch.

5. Move to the grid and click stitch for placement.

Fill an Area

Note you cannot fill with double symbols.

4



If you wish to fill an area with the Current Stitch, continue. If you wish to use a different stitch,
click the Pencil Button and click a stitch.

To fill an area:

1. Current Stitch.

2. | Click Select tool.

3. Select area.
4. ™ Click Fill Button.

T
.

5. The area is filled with the Current Stitch.

Change Color

| The Change Color tool allows you to change a color throughout the whole grid. It is important to
note that if your colors are dithered and not solid, you will not see any change occur.

Change Color

In this example, I am going to change the navy to red.
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1. Click Change Color Button. -
2. Click on the color red.

3. Click on any navy stitch in the grid.
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Printing

Stitch & Motif Maker will print your grid to the specified gauge.

If the printout is going to span more than 4 pages, you will receive a warning message.

In the case of a large printout, you may wish to export your chart as a .jpg or a .bmp file and use
another Windows graphics program or Word to print. You can then size the printout to match your
specifications.

You will find the export to a .bmp or to a .jpg in the Export Tools Menu.

Also, if you printer does not have enough memory to print a large chart, you will receive a
warning. Do not despair. Go to the Export Menu.

.smm Files

Stitch & Motif Maker files for Version 3 are saved with the .smm extension. A .smm file cannot
be opened in any other program, therefore if you wish to use your charts with other Windows
programs, please use the Export Tools menu.

Stitch & Motif Maker files not only contain the chart but any relevant information to your design,
such a gauge, or custom colors, or grid line colors. They are not pure graphic files.

Export Tools

Export Tools Overview

Export tools are provided for your convenience. They are not necessary to the basic functions of
the program. The Export Tools Menu is provided as both an option for those who would like to
take their designs one step farther, and as a back-up for printing.

Export to Paint for Legend

If you are sharing your finished chart with another knitter, you may wish to create a legend for
your symbols.

Create a new chart with the number of rows representing the number of different stitches you have
used. Set the number of stitches to the widest stitch used.

For this example, I will use the honeycomb stitch mentioned elsewhere in Help.

The widest expanse of the cable is 4 sts. My legend will be 4 sts wide.
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I use a right slanting cable and a left slanting cable = 2 rows.

The blank squares are K on the RS, P on the wrong side = 1 row.
To create this legend:

Click New.

Set the grid to be 4 sts wide and 3 rows high.

Draw the stitches in Stitch & Motif Maker.

Click Export Tools.
Click Export to Paint for Legend.

Paint will open with chart on the left and white space to type the stitch descriptions.

HERTEN
| LT

Click the Text tool in Paint.

With the Text tool down, draw a box to the right of the first row of stitches and type the stitch
description.

Do this for each line of stitches.

Save as a .bmp or .jpg to be used with your Stitch & Motif Maker pattern.
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Export Full Grid to Paint

| To access this function, click Export Tools Menu.
Click Export Full Grid to Paint.
Paint will open with the grid in place.

This function is useful it you wish to incorporate your grid into your word processor or another
graphics program without actually saving it is a .bmp or .jpg.

To paste into another graphics program, click Edit, click Select All, Click Copy.
Open second graphics program or word processor. Click Edit. Click Paste.

You may also want to adjust color or add other details to the chart in paint.

Export Full Grid to Paint Without Numbers

| Click Export Tools Menu.
Click Export Full Grid to Paint Without Numbers.

Paint will open and the chart will be in place.

Export to Graphic Format

You can export your charts or legends to other graphics formats that will be useful with other
Windows programs. Please be sure to save as a .smm file first, as you cannot import these files
and edit them in Stitch & Motif Maker.

The .smm file is a large file and not one that would be easily added to a web page or sent by email
to a friend. I recommend that if you wish to share or to use any chart with other Windows

programs, export it as a .bmp or .jpg.

The .jpg format is a much smaller file and is probably the most useful.

Troubleshooting

Printing Problems

| The Export Tools menu has been provided as a backup for any printing problems. If the chart will
not print properly from Stitch & Motif Maker or you receive an error message, please export the
file as a .bmp or .jpg and print from another Windows graphics program.
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Since MS Paint is provided with all Windows OS version, an automatic link for executing Paint is
provided for your convenience.

Out of Memory Error

You may receive an Out of Memory Error message if your chart is too large for your system
capacity.

Save your work often!

However, test your system. If you find that your system is slowing down while you are working,
then create grids that are smaller and work on your designs in sections.
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Sources

At the time of writing this program, there is still not a standardized system of Symbol Craft. There
are many symbols which represent the same working of a stitch. This is by design, since it seems
many knitters have their favorite set of symbols.

Symbols used in this program were suggested by:

Vogue Knitting: The Ultimate Knitting Book, Butterick Company, 1989.

The Big Book of Knitting, Buss, Katharina, Sterling Publishing Co, New York, 1999.

450 Knitting Stitches Harmony Guide, Collins & Brown, 1999.

Charted Knitting Designs, Walker, Barbara G., Charles Scribner’s Sons, New York, 1972.
Viking Patterns for Knitting, Lavold, Elsbeth, Trafalgar Square, 2000.

Aran Knitting, Starmore, Alice, Interweave Press, 1997.
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